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Introduction 
This user guide is dedicated to Manage for TEOS, Sony’s solution offering a complete display device 

and room management solution for corporate environments that’s powerful, flexible and easy to use. 

 
Manage for TEOS streamlines the control and maintenance of all your connected devices and content 

in boardrooms, meeting rooms, offices, reception areas, public spaces and other locations. 

 
This easy-to-use solution simplifies monitoring of the operational status of all networked displays, 

projectors and other devices via a friendly dashboard-style  

interface. Group devices by location for easier management. Schedule content playout and even 

create your own impressive digital signage in minutes. Integrate screens with  

 
our centralized bookings system to display meeting schedules in each room. Rapidly pinpoint issues 

with any device that isn’t working. 

 
Latest update enables organisations to move towards smart workplaces by allowing customers to 

control AV devices from their own smartphones, use tablets to book meeting rooms and create a 

virtual receptionist.
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Log-in for the first time 

To login in Manage for TEOS, you can use your favourite browser and navigate to the Manage for 

TEOS URL. By default, this URL is http://teos.manage, which we will use in this manual. It can be 

configured during Manage for TEOS installation. 

  

  

 

Your administrator has created a username and password for you, which you can use to login in 

Manage for TEOS. 

 
Fill in your credentials and click “Log In”. 

 
Please note that the first time you open and login to Manage for TEOS, it can take some time. 
 

Locked out 
 
It might be possible that your company has the lock out functionality active. This means you will only 
have 5 attempts to login. If you fail you will be locked out. You have to ask your administrator to 
release your account again. After the account is released you can use the “Lost your password” option 
or ask the administrator for a new password. 

 
 
 

 

http://teos.manage/
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Forgot your password 
 

If you forgot your password, you can use the “Lost your password?” option. When you click on this you 
will get the following screen: 
 

 
 
 

On this screen you can fill in your e-mail address and you will receive an e-mail to reset your 
password. 
 
 

Language Selection 
 
You also have the option in the Log In screen to already select your language. The available 
languages are: 
 

 
 
 
When selecting a language, TEOS Administration interface or Employee app will automatically change 
to the language. This option is not applied to the workplace solution. Depending on the solution a 
translation option can be proposed where the user can define based on the languages available the 
word or image into the solution.  
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Global overview dashboard 
 

After you log-in, you will see the following screen, which is called “Global Overview”: 

 
In the Global overview you can see the original Global overview which will display the devices in a 
device localization. Also, if there are any issues for these devices these issues will be shown. 
Using the tabs in Global overview a user can go to: 

 

1 Dashboard (overview of all the platform statistics in a synthetic view) 

o About Device usages, with the total number of device and total energy cost. A Graph 
shows per day the usage of device (updated daily). 

o Meeting room usages, with the number of meeting, the average meeting duration and a 
graph with the number of meeting hosted in a day (updated daily). 

o Number of visitors, with the number of visitors per day and the average visit duration with 
a graph showing the number of users per hours (updated daily). 

o Signage usage, with the number of hours of content played in a day, the incident rate and 
in the graph the signage scheduled vs signage played in a day (updated daily). 

o Device issues showed if a device got disconnected on having a behaviour not expected. If 
an alert is sent by mail the table will show the information 

2 Device statistics with more detailed statistics dedicated on device (AV) usage and incidents 

3 Room statistics with detailed statistics on meeting rooms usage, incidents and consumption 

4 Reception statistics with statistics on reception solution, with reception activity, number of visitors 

5 Employee statistics, about the check-in of employees with the reception solution  

6 Signage statistics with hours of content played, average runtime per day etc.  

7 Meeting Statistics with the number of presentations in HDMI or Connect for TEOS  durations etc.  

8 Tenant Statistics, with the number of hours per month, per year of spaces usage per tenant or 
admin 
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Device Statistics 

 
Device statistics page is focused on the device states, the power consumption and the events on their 
usages.  Within this page you can find several datasets on devices and can filter based on dates (start-
end) locations (from company, site to device and interval (from 30 minutes to 1 week). 
All the dataset can be filtered based on a period of time, a location (from Site to meeting room) and 
interval from 30 minutes to 1 week 
Dataset available:  
- Number of devices 
- Number of incidents (disconnected) 
- Average device run time 
- Availabilty rate 
- Energy consumption 
- Energy cost 
- Number of devices per type 
- Energy consumption per device type 
- Incident reports  
A report editor is available to be able to mix this dataset with other datasets in the TEOS platform 
and from other platforms 
  

Room Statistics 
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Room statistics page is focused on the room usage with a dedicated table showing the number of 
minutes used and occupancy percentage of meeting rooms (can be up to one specific meeting rooms) to 
give a better understanding on how the meeting rooms are used based on calendar bookings and 
presence validation. All the dataset can be filtered based on a period of time, a location (from Site to 
meeting room) and interval from 30 minutes to 1 week 
Dataset available:  
- Number of meeting rooms 
- Number of meetings  
- Average meeting duration 
- Booking rate 
- Average check-in time 
- Most used rooms  
- Least used rooms 
- Number of HDMI presentation 
- Average HDMI presentation 
- Number of TEOS Connect presentation and time  
- Meeting room events  
- Presentation events  
- Occupancy per room with average time and occupancy % 
A report editor is available to be able to mix this dataset with other datasets in the TEOS platform 
and from other platforms 
 

Desk Statistics 
 

 
 
Desk statistics page is focused on the desk usage (not for desk zones) which is including the des 
occupancy percentage and the amount in minutes of usage of each desk. This data can help giving 
options to facility managers with spaces. All the dataset can be filtered based on a period of time, a 
location (from Site to meeting room) and interval from 30 minutes to 1 week 
Dataset available:  
- Number of desks 
- Number of bookings 
- Average booking duration 
- Booking rate 
- Average check-in time 
- Most used rooms  
- Least used rooms 
- Occupancy per room with average time and occupancy % 
A report editor is available to be able to mix this dataset with other datasets in the TEOS platform 
and from other platforms 
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Reception Statistics 
 

 
 
Reception statistics page is giving an overview of the number of visitors per day giving event information 
as well about visitors who sign in and out, this information is updated hourly. You can get an export data 
with the sign in date and sign out date including the visitor name and receive also it automatically by mail. 
All the datasets can be filtered based on a period of time, a location (from Site to meeting room) and 
interval from 30 minutes to 1 week 
Dataset available:  
- Number of receptions  
- Number of visitors 
- Average visit duration  
- Most used reception  
- Expected visitors (with secured method) 
- Visitors no-shows (with secured method) 
- Events (live after refresh) 
A report editor is available to be able to mix this dataset with other datasets in the TEOS platform 
and from other platforms 
 

Employee Statistics 
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Employee statistics will highlight the employee usage of spaces, with filtering based on date period, 
locations, employees, and interval of time in the period. All the dataset can be filtered based on a period 
of time, a location (from Site to meeting room) and interval from 30 minutes to 1 week 
Dataset available:  
- Number of users checked-in 
- Employee check rate 
- Average time spent  
- Capacity check-in rate  
- Employee check-ins and outs events 
A report editor is available to be able to mix this dataset with other datasets in the TEOS platform 
and from other platforms 
 

Signage Statistics 
 

 
 
Signage statistics are orientated on the Signage presentation usage, the playlist usages with the number 
of time of playlist used and the page usage with a content played. All the dataset can be filtered based on 
a period of time, a location (from Site to meeting room) and interval from 30 minutes to 1 week.Dataset 
available:  
- Presentation usage  
- Playlist usage  
- Page usage  
A report editor is available to be able to mix this dataset with other datasets in the TEOS platform 
and from other platforms 
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Tenant Statistics 

 
Tenants statistics are dedicated for the specific tenant management usage where an administration can 
get an overview and extract the meeting room usage time as well as if the tenant reach the limit of his 
available hours for the room use (only information). A Tenant will see his own statistics and not the other 
tenants stats. All the dataset can be filtered based on a period of time, a location (from Site to meeting 
room) and interval from 30 minutes to 1 week 
Dataset available:  
- Hours booked  
- Monthly quota used 
- Tenant 
- Locations used 
- Start date  
- Monthly quota 
- Yearly quota  
A report editor is available to be able to mix this dataset with other datasets in the TEOS platform 
and from other platforms 
 

Custom Reports 

 
From version 3.2 of TEOS, custom reports can be done where all the datasets available in TEOS from 
devices, to rooms, to desks to employees or signage or even external datas can be used to create 
custom reports and receive them by mail with the alert management function. All the dataset present in 
TEOS to be used in this web designer from AR  
For an online help on how to use the tool, please go to the following website:  
https://www.grapecity.com/activereportsnet/docs/latest/online-webdesigner/overview.html  

https://www.grapecity.com/activereportsnet/docs/latest/online-webdesigner/overview.html
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Top menu 
 
In the header section of Manage for TEOS, you will have the following options: 

• Search  
• Bookmarks   

• Alarms (quick menu)  

• User (Edit profile and Sign out)  
 

 

 

Search  
 

 

The Search bar gives you the option to search in Devices, Sites Configuration and Menu items. 

For example, you are looking for a Site Configuration called “TEOS” type “teos” in the search bar 

and click on the “Sites Configuration” tab. 

 

 

Bookmarks 
By clicking the Bookmarks icon you open the Bookmarks side pane 
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Alarms 
When you click on “Alarms”, you will be redirected to the Alarm configuration section. In that section, 

you can: 

 

 Create alarms by clicking the “Add alarm” button 

 See an overview of the existing alarms 

 
 

After clicking “Add alarm”, you can: 

 

 Fill in a logical name for the alarm 

 Select the alarm type: “Media” or” Signage content” 

 Select the groups where the alarm needs to be active in case you trigger it. 

 When you select the tick box “Add to quick menu”, the alarm can be triggered from the quick 

menu in the header 

 When you have selected a group and chose to activate the “Allow interactive control” 

checkbox a “Show interactive URL’s button will be activated which will show you the start and 

stop URL’s for the device. 

 

Alarm quick menu 
 

The Alarm quick menu has been developed to activate alarms very quickly. The menu contains all the 

alarms where the tick box “Add to quick menu” has been selected. To open the quick menu, you need 

to hover your mouse above the alarm button, and it will pop-up. 
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If you want to trigger one of the configured alarms, you then need to press the run button. The alarm 

will be triggered on the group that is configured in the alarm itself. When you deselect the group and 

click the stop button, the alarm will stop, and the devices will return to their normal state. 

 

Language selection 
 

To select your preferred language, click on the country flag you preferred. The default language is set 

to English. Other languages available are: Dutch, German, French, Italian, Polish, Spanish, Russian, 

Arabic, Hebrew, Portuguese, Japanese, Thai, Simplified Chinese, Traditional Chinese (15). Your 

preferred language will be saved in your user profile. 

 
 

Log off 
 

In order to log-off, you can click the “Log off” button in the header. Manage for TEOS will log you out 

and will return to the login page. 
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Server Management 
 

 

In Server Management you have the following options: 

 

• Server dashboard 

• Settings 

• Alerts Management 

• Wizard 

• Back-up and Restore 

 

These options are meant for Administrators. Please refer to the “Server Management” section in 

Manage for TEOS administrator guide. 
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Sites Management  
 

When you go to Sites Management in the TEOS Navigation menu you have the following options: 
 

• Sites Overview 

• Sites Configuration 

• Tenants Management 

• Service Management 
 

Sites Overview 
 

This part of Manage for TEOS is only accessible if you have the rights or has a specific pre-configured 

role. 

In Site Management you can create an easy overview where you can setup the complete structure of 

the company and also setup in which room which devices are available. You can also edit this 

structure easily and control the devices individually or for example turn on/off the power for a whole 

group.  

The pre-configured roles that have access are:  

• Administrator 

• Power User  

• Facility Manager  

• IT Manager  

• AV Manager  

An administrator can also create new roles and add these rights. So if a user needs the rights to Site 

Management the administrator should be asked to provide these rights.  

To access Site Management, go to Administration in the menu options. It should be the first tab so you 

should already be in Site Management when you click on Administration.  

Else you should click on the tab Site Management.  

Overview  
When you go to menu option Sites Management it will show you the Sites Overview tab. Here you can 

quickly see the Power status, Meeting room status and Incident status of your devices per Company, 

Site, Building, Floor, Area. You can select in the dropdown which status you would like to see in the 

overview. 
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To see the information for a group from the Sites Overview page, you can filter on the left side for the 
group you want the information from. You can also select on the child group displayed in the 
overview. For example, clicking on Floor 1 will navigate you to the child group, where you can see all 

the meetingrooms.  
  

 
  
To manage devices you can click on the virtual remote icon (upper right corner) of Floor 1.  
  

 
  

 
  

With this remote you can easily power your devices on and off.  
The icon for the group (area) will turn green when one of the devices that is giving back a power status is 
switched on.  
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How to setup a overview structure?  
 
The easiest way to create you structure is to go to menu item “Sites Management” and click on the tab 
“Sites Configuration” tab. The first thing you want to do is create a Company. You do this by pressing 

the button Add Device group:  
 
This option will open the following screen: 
 

 
 
You have to give the Company a name and the other fields are optional. If you add an image/logo it 
will also show this image/logo in the Sites Management overview.  
 
For a Company you don’t have to fill in the Parent field unless for some reason you want to add a 
Company within a Company. 
 
When you click “Save” the company will now show in the overview. 
 
When you want to add a following group just press Add Device group again, select the Previously 
created group as a parent. You now want to at least set a name again and a group type. If you want to 
change a group you can always “Edit group” from Sites Management. 
 
This way you can build your structure easily within Sites Management.  
 
Be careful with deleting a group that has child groups. You can always find these back in 
Administration -> Sites Configuration but it may cause that some blocks lose their parent and are not 
visible anymore. This is fixed easily if you connect it again to a correct parent group. 

 

Types 
 

 Level 1: Company. If your structure doesn’t start with a Company, the Sites Management will not 
show. A Company is always required as your starting point for creating a structure. 

 Level 2: Site, which can be an office or a campus. (actual address) 
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 Level 3: Building  

 Level 4: Floor  

 Level 5: Area, which can be a:  
o Meeting room 
o Reception 
o Restaurant 
o Open space 
o Closed office 
o Common area 
o Desk 

 

 
There are two special rooms in the list: meeting rooms and desks. 

 

Meeting room 

A Meeting Room is a special area on which you can define virtually more value with rules/data 

for each space.  

  

When editing the meeting room and going to meeting Room tab, you will have the following 

options:  

• Active, enable/disable the meeting room  

• Room type, advanced setting (Business/Corporate/Mixed)  

• Description, description of the meeting room (can be seen in Employee app)   

• Capacity, can be used as filter in the employee app or seen into the interface and in the room booking 

interface “find another room”  

• Early check-in and cancel, allow the check-in/cancel to your user up to 29 minutes before the meeting 

starts  

• Cancel time, allow the check-in to your user up to 29 minutes after the meeting starts  

• Unavailability after each meeting, you can define here a reason and the duration where TEOS is 

booking automatically the space  

• Allow special services and Special services e-mail address to allow the request for catering for 

example in the meeting room.   

• Equipment select the equipment available in the meeting room. More equipment can be created in 

administration > equipment. Employee app or the Outlook Universal Add-in will be able to filter the 

rooms based on this equipment selection.   

• User group and roles, this will allow you to define which type of user can see the meeting room  

• Content, set up your content:  

o Room Booking presentation, created under workplace solution > room booking, you can affect the 

design of the room booking tablet in this section or directly from room booking menu.    

o "Find another room" base, set the localization when using Find another room.  



 

 

20 | Manage for TEOS - User guide 

o Meeting room calendar is the external datasource added (in Media and Data > External Data 

source and after O365, Microsoft Exchange, Google Calendar or TEOS Calendar). You can 

attach the calendar in this section or again in room booking menu   

o Export calendar events received into TEOS Platform; you can select the data from a start to an 

end date.   

o Room control presentation, create in Workplace Solutions > Room control   

o Mirroring Template, select the template for mirroring  

o Meeting interface (old BRAVIA Meeting room interface), where you can assign the interface of the 

BRAVIA from Workplace Solutions > Meeting Interface   

Meeting interface (new BRAVIA and Player meeting room interface), where you can assign the 
interface of the BRAVIA from Workplace Solutions > Meeting Interface 

 

 
 
You have multiple settings in the Meeting Room tab. 
 

Settings 
 
1. Description, the description of the meeting. 
2. Capacity, the maximum amount of people that can be in this meeting room 
3. Check in time, the amount of minutes before the official start of the meeting that you can start a 

meeting. Make sure there is no meeting still going on. 
4. Cancel time, the amount of minutes after the official start time that a meeting is auto cancelled if 

not started in time. The room will be available for booking again. 
5. Incident mail address, when an incident is reported in the room with the Employee App for TEOS 

this incident will be send to this e-mail address. An incident can only be reported when the meeting 
has started. 

6. Unavailable after each meeting: You can configure a time which should be reserved after each 
meeting. You could configure this for example to make sure there’s time for people to leave/enter 
the room, or for cleaners to clean the room. 

7. Allow special services, if this option is checked then people are allowed to make special requests 
for a meeting room when using the Employee App for TEOS, for example if they would like to have 
coffee during the meeting. 

8. Special services mail address, when special services are requested for a meeting these 
requests are send to this mail address. 

9. Equipment, this will display which equipment is available in this room when using the Employee 
App for TEOS. To add equipment to the list, go to Administration -> Equipment Management. 

10. Default schedules 
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11. Within the default schedule tab, you will be able to select if the Meeting room is not following the 

building schedules (for opening hours) or inherit from parent to get the rules from a more important 

meeting room or even from a site or building schedules for power management. A dedicated 

schedule independent from the building can be define for a specific meeting room.   

 

 

12. Travel distances can be added in minutes between meeting rooms and desks to show on the book 

another room function or within the employee app the travel time to arrive from a space to another 

 

13. A dedicated QR code will be generated for a user to book/check-in/cancel a meeting using the 

employee or Mobile app. This QR code is sprinted and added in the entrance of the space.  

 

 

 

14. Service & Catering and Incident management  

A catalog of service/catering and incident can be created in TEOS under Site management > 

Service and catering and under incident tab with the different options to give to a user when using 

a meeting room. This is then applied inside the device localization with the email address where 

the request will be sent. The service and catering as well as incident can be reported from tablet 

interface and for the employee/mobile app. The service and catering can be requested from an 

outlook add-in or the employee app, and a vendor dashboard is available according to the new 

developments done in version 3.2 of TEOS.  Please go to the documentation Service & Catering 

– Installation and user guide to get more details about this new feature 
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Groupe type > Desk 
Desks are special areas on which you can define more value with rules/data for each space.   
When editing the desk and going to meeting Room tab, you will have the following options:  

• Active, enable/disable the desk  

• Room type, advanced setting (Business/Corporate/Mixed)     

• Description of the desk (can be seen into Employee app)   

• Early check-in and cancel, allow the check-in/cancel to your user up to 29 minutes before the 
booking starts  

• Cancel time, allow the check-in to your user up to 29 minutes after the booking starts  

• Incident email: insert the email address of the support team. From the employee app, a user will 
be able to send a message to this email address to report an issue in the desk. General email in 
settings must be configured for this option to work.   

• Unavailability after each meeting, you can define here a reason and the duration where TEOS is 
booking automatically the space  

• Allow special services and special services e-mail address to allow the request for catering for 
example in the desk.   

• Equipment select the equipment available in the meeting room. More equipment can be created 
in administration > equipment. Employee app will be able to filter the desks based on this 
equipment selection.   

• User group and roles will allow you to define which type of user can see the desks  

• Content, you will be able to affect the calendar to the desk in order to be able to book the desk. 
The calendar is the external datasource added (in Media and Data > External Data source and 
after O365, Microsoft Exchange, Google Calendar or TEOS Calendar). 

 
Content 
 
1. Room booking presentation 

the room booking presentation can be created in Workplace Solutions -> Room Booking in Manage 
for TEOS. To add this Room booking presentation just select it in the Room booking presentation 
dropdown. This will add signage to the meeting room so people can book the room using a Book 
for TEOS tablet which is at the meeting room itself. You have to select it at the device in Device 
management if you want to make use of this Room booking signage: 
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When selecting this option License type in Device settings has to be set on “Signage” or “Tablet”. 
The License type “Meeting Room” is meant for MRA. 
Meeting room device type has to be “Room Booking”. 
 

2. Meeting room calendar 
the calendar being used for the room booking. This can be an Office 365, Google or a Calendar for 
TEOS.  

3. Room control presentation 
this is signage that can be added in Add-Ons in Manage for TEOS and this will add Remote for 
TEOS to the meeting room. You have to select it at the device in Device management if you want 
to make use of this Room control signage: 
 

 
 
Meeting room control 

 
Device control 
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Third party displays are only controllable using Simple Control license using basic IP connection. 
These will only show basic status on/off and you can only control the on/off and inputs functions on 
these displays. 

 

4. Mirroring Template 

If you have Connect for TEOS  linked to Manage for TEOS, you can also select a Mirroring template 
to use which you can customize in Manage for TEOS. To create your own customized Mirroring 
template, you need to navigate to Workplace Solutions -> Mirroring.  
In here you can create a new solution, and afterwards edit the template. 

 

 

5. BRAVIA Meeting Interface (only for older installations than February 2021) 

To configure MRA from Manage for TEOS. To create this configuration, you can go to Workplace 
Solutions -> BRAVIA Meeting Interface. For this you need the advanced MRA. The simple MRA 
installed on your BRAVIA will not work. 

 

6. Meeting Display 

Following the Bravia Meeting Interface, there’s now the NEW Meeting Display Solution. 

The Meeting Display Solution can be used to show meeting information on a display in a meetingroom. 

When there’s no meeting active, a screensaver can be configured. 

 

During a meeting you can also connect with Connect for TEOS or HDMI to the display. If this session 

gets disconnected afterwards, it will return to showing the meeting display. 

 

To create a meeting Display, please navigate to Workplace Solutions -> Meeting Display. 

In here you can create a New Meeting Display. 
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To create a Meeting display you need to give it a name and select one of the available templates.  

The following two options are to configure alerts for when meetings are about to be end. These 

configured Alerts will show up in a small overlay on your BRAVIA when it is X configured minutes untill 

your meeting ends. A specific text can be applied to shown the message  

You can also configure if a meeting has passed, you want to force all active HDMI/Connect for TEOS 

sessions to end, or to keep displaying them. 

 

You can enable a screensaver for the idle periods of the meeting room. A screensaver is a normal 

Signage presentation which can start playing after x idle time configured. You can also configure how 

many minutes before a meeting the screensaver should stop, or how many minutes after the meeting 

the screensaver should start.  

With the last checkbox you can enable if the screensaver can be stopped by touching the display, or if 

it can only be stopped by the configured timers. 

 

The final option enables you to hide or show the Connect for TEOS information within the template.  

 
 

Desk 
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For a desk you have less options than a meeting room, but it basically works like a meeting room. You 
can book a desk like a meeting room using an Office 365, Google or a Calendar for TEOS. 
 
Desk options are now available since version 3.1 with the possibility to define if the desk in booked on 
flexible time, for half day slots or for full day.  
Like for the meeting room, workflows with QR code for booking/check-in/cancelling are available for desks  
 
For a Desk you can create a stand-alone Calendar for TEOS in Media and Data -> External Data. You 
can of course also choose to use an Office365 or Google calendar. 
 

 

User Groups / Roles 
 
Setting these user Groups / Roles makes a meeting room only available to book using Manage for 
TEOS for only the group of users who are allowed to book this meeting room. 

 

Building, floors and areas  
  

We can click on the building block, in our example named "Main Building" to go deeper in the 

overview. Now it will show you the Floors and Area's in this building.  

This can be different for you of course it just depends on how your administrator setup his 

device groups.  

 

 

 

Navigation  
  

If you want to navigate back (to the upper level) then click on the most left block. In our example this is 

the building named "TEOS Company".  

    

Devices in an area  
  

If you click on an Area block. In our example the meeting room "Test Meeting Room 1" it will show a 

popup with the devices in this Area:  

 

Remote control for the displayed devices  
 

To manage devices, you can click on the virtual remote icon in the Meetingroom. You need to have 
devices associated into your area to be able to see the remote logo on the top right side of the space.  
On each type of group, you will see different information. For the Site you can see the number of 
employees (users registered in TEOS, visitors), devices, meeting rooms and desks, you can see the 
name of the area created as well. If you have a device attached to the area you will be able to see the 
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remote logo appearing where you can click on to show the virtual remote. For device groups which 
have controllable devices within them, you can click on the remote icon (). This opens the virtual 
remote to allow you to control the devices.  
 

                      
 

 

  

With this remote you can easily control your device remotely.  

 

Same as with room control third party displays are only controllable using Simple Control license using 
basic IP connection. These will only show basic status on/off and you can only control the on/off and 
inputs functions on these displays. 

 

You can see what Signage is playing on the selected device because Execute Command will now 
show a screen capture to the user. Not all the buttons might be supported for your device. The most 
important to remember is that you can’t switch of a TEOS Player. Because once switched of Manage 
for TEOS will lose control over the TEOS Player. 
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Sites Configuration 
 

In Sites Configuration you can find all the Device groups created within Manage for TEOS. Also the 
orphan items. Items that don’t have a link with a company. You can only view this section if you have 
the rights to view this or if you are an administrator. Here you can also add, edit and delete Device 
groups. 

   
 
 

Tenants Management 
 

In Site Management a new tab has been added in v.2.1.6 called Tenants Management. This is especially 
for space booking purpose where an administrator can give access using a Calendar for TEOS interface 
or the employee app to other companies assigning a number of hours per month and per year and get 
by mail or via the statistics the usage of the spaces and be able to invoice it to the company renting the 
spaces.  

 

 
 



 

 

29 | Manage for TEOS - User guide 

Inside the tenant management menu, you can find the following information to fill: 
 

- Name: Name of the tenant 
- Image/Logo: To set an image/logo that will show on the Book for TEOS if a tenant books a 

room. 
- Start date: Start date for the tenant (to be able to count the number of hours) 
- Per month:  Monthly quota for the tenant to define 
- Per year:  Yearly quota for the tenant to define  
- Send Monthly report to tenant: When enabled you can configure a subject and an HTML 

template for a monthly report email. 
- Send Monthly report to tenant when over quota: When enabled you can configure a 

subject and an HTML template for a report email to be sent, when the tenant reaches the 
configured quota. 

- Send report emails to: Configure the email address that the report emails should be send to. 
- Tenant Localization: The localization that is set for the tenant 

User Management for Tenants 
 
In Administration – Users management you can create or edit a user and set the tenant this user. 
 

 
 

Tenant statistics 
 
When you go to Dashboard – Tenant Statistics. When you go to this tab you can see how many hours 
this tenant has used already for the month and for the year. If the tenant uses more than the set quota 
then an email is sent to the set email address. 
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For more details, please consult the Quick start Guide for more information and a step-by-step 
configuration process. This guide can be found in our https://teos.solutions/resources website. 
 
 

Sites Configuration 
 

Service Management 
 

 
 
On the Service management tab you will see an overview of your devices. Here you can manually add 
a date for the “Warranty until” date. 

By clicking the access device logs (only on premise) button  you can access and 
download the device logs for a selected time span. 
 

Updates 
 
Within TEOS there also is an option now to update apps and firmware, download device logs and an 
option to remotely configure your device. These updates can also be scheduled. To be able to do this 
of course you need the rights or the right role. 
In front of the device the following options might be available: 
 

Selection 

 Download Logs 

Update Firmware 

Update / install Android app 

Remotely configure device 
 

Selection icon 
 
This is to select one or more devices before you press the big download logs button in the top right of 
the screen. 
 

Download logs icon 
 
This is to download device logs from the specific device. 

https://teos.solutions/resources
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Update Firmware 
 

This gives you the option to update firmware for a Sony BRAVIA using Manage for TEOS. You need 
the latest *.pkg file from Sony to be able to do this.  
 

 
 

 
 
When installing this it will show you within TEOS when it is installing the firmware and will also show 
you when it is finished. On the BRAVIA itself you can see the progress of the installation. 
 

Update / install Android app 
 

Here you can update your Android App for TEOS s on your device. (TEOS Android Player, Control for 
TEOS, Connect for TEOS ) 
 

 
 

Test ADB 
 

This button is to check if there is a connection to the device and ADB installed on your computer. 
Sometimes you have to press cancel and press Test ADB again and if it still doesn’t work then there 
might be 2 issues possible. It might be possible that someone created an ADB connection outside of 
Manage for TEOS manually which will not be very likely. The other thing that might be wrong is that 
ADB debugging is not activated on the Sony BRAVIA in settings -> developer options. 
 
Time zone can be from version 3.1 pushed from TEOS central server as well as NTP IP for the 
devices to always be synchronised with correct time. The time zone information is shown in TEOS tab  
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The latest versions of the TEOS Apps should be selectable from the dropdown. If you have received a 
newer version you can also manually upload the newer version of the software. 

 
 
When you don’t want to install the update “Now” you can also select “Scheduled time”. 

 
 
Scheduling in the past is not possible. 
Once scheduled if you refresh the page you will see a number behind the Scheduled App Installations 
button. If you click on this button you can see the scheduled installations. 
 

 
 

Updates available 
In the overview you can also see if there is a newer version of software available. If the newer version 
is uploaded it will be available in the dropdown. A job will check after several minutes which devices 
can be updated. The software for these devices will highlight with an exclamation point in the . 
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Administration 

 
 
The menu “Administration” offers you the following main options: 

 

- Manage devices, Building/IoT controllers and assets 

- Manage your users (users and group of users)  

- Do advanced configuration (Active Directory configuration) 

 

Manage devices and assets 
This section is used to configure all your devices, divided by a logical structure 

 
 

AV Devices 
In the devices list overview, you will see the list of all the devices that are added inside your Manage 
for TEOS solution: 
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Devices  
 
In the devices overview dashboard, you will see an overview of your connected devices. In this 
overview, you can: 
 

• Add devices 

• Auto discover devices in your network 

• Import excel to easy add a list of devices using a template 

• Change devices that you have selected 

• Define with filters the research and keep your research until it is resetted  

 
The explanation on adding devices are handled in the Manage for TEOS administrator guide.  
 

 

Reboot your devices 
 
It is recommended that you reboot your devices every day. You can do this using Actions 
Management within TEOS. Here you can add a daily schedule where you can add as an “Action Type” 
the action “Reboot”. You can set this for a specific device but also for complete device groups. 
 

Device Groups 
 
In the device groups overview, you can edit or delete device groups. When you select a device group, 
the devices overview will only show the devices that are configured in that group. 

 
*The Remote for TEOS app is currently only available for Android devices 

 

Devices actions 
 

In the devices list overview, you will see the list of all the devices that are added inside your 

Manage for TEOS solution: 

 

Device options 
 

In  front of the devices on the Device Management screen you will see the following icons: 

Edit Delete  Execute command  Update screen 

 

Edit  
 

With the “Edit Device” option, you can edit all the device preferences. The items you can edit depends 
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on the license you have chosen for the device. There are four licenses available: 
 

 Advanced license (for all content management and device control) 

 Simple license (for device control only, action scheduling and firmware for BRAVIA) 

 
 

The items “Edit device” and “Delete device” are covered in the administrator manual. In this user 

manual, we will focus on the other elements. 

 

**A NFC tag can be written with a NFC writer app, or with additional Windows hardware 

 
 

Execute command 
 

This option allows you to send commands directly to the device. For scheduling please refer to 

“Actions Management” in this manual. When you click the “Execute command” button, a popup will 

appear: 
 

 
 
You can click on a button of that remote control and this command will be sent to the device 

immediately by IP. After sending the command, you will see a message beneath the remote control: 

When you see this notification, it means the screen did respond and has executed the command 

properly. 

 

Update Device  

The update screen option  sends the last configuration to the device. For example, when you 

have changed the background of your meeting room screen, you can force the update by pressing 

this “Update screen” button. 
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Preview 

 

The preview functionality is now built in the Execute Command in TEOS 2.2 as seen in the picture 

above. 

 

General 
 

Within the General tab you can set the settings for the selected device. An Advanced license is 

required on the device to be able to play content. 

You need to select the Device type in combination with a license. You can select from: 

• No license 

• Entry license: Simple control, only control no option to play signage. 

• Advanced License: you will be able to use the Meeting Display, Signage, to display signage on 

your device or also for tablet, to display signage, meeting rooms or room control on tablets (only 

when you select tablet as Device type) 

When you select tablet in combination with a tablet license you have the option to select a Meeting 

Room device type. You can select from: 

• None, if you want to display normal signage on your tablet. 

• Room/desk Booking, to display your room booking signage. 

• Dual Booking, to be able to display 2 meeting rooms in one tablet  

• Room Control, to display room control signage on your tablet to control the devices in the 

meeting room. 

• Reservation system, on a tablet you will be able to book not only for the same day like in room 

booking but for a longer period  
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When you select Display with a Signage license for example you also get an option Block when on 

external input. With this option you can block signage to be displayed when an external device like 

a player is plugged into the display.  

You will also see an option to ignore any schedules that are set within Manage for TEOS (except 

alarms these will always have priority).  

With the "Always in front" option, the TEOS Application will always be in the foreground. Even when 

a user selects an input manually, the application will always overrule. (except when an alarm is 

playing) 

We recommend applying that feature for displays dedicated to signage. 

 

Mirroring Settings 
 

On the Mirroring Settings tab you can push (and re-push) a Connect for TEOS license when you 

have Connect for TEOS installed and running on your display. You need to activate the checkbox 

and press the refresh button behind it.  

You need Connect for TEOS licenses for this (TEC-SC100. To see how many licenses, you still 

have left for usage you can see this in the Server dashboard tab in Server Management. 

  

 

You can activate the Show welcome page checkbox if you want to display the welcome page 

(mirroring template). 

This welcome page can be set up in Workplace solutions and can be selected after saving in the 

Mirroring Template dropdown. 

 

Signage Settings 
 

On the Signage Settings sub-menu, you can set the signage properties and create a schedule for 

each device specifically. There also is an option to select a default presentation. 
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When you click on the dropdown for “Default presentation” you can select a default  
presentation that will be shown on the device. 
  
When you click the "Proof of play logging" checkbox it will create a log of the Signage that is being 
displayed. You can see the logging when you go to "Proof of play" in Content Creation.  
The logging will be shown after 100 pages are displayed.  

 

Status 
 

The Status section gives you information related to the device’s status: 

 

 
 
In the status overview you have the following items: 

 Last Update - This displays the latest status update that is retrieved from the display 

 Power Status - Power status shows the actual power status of the device 

 Volume Level - The actual volume level of the device 

 Current Input - Shows the input that is currently used on the device 

 Serial Number - Shows the device serial number 

 Model Name - Shows the model number of the device 

 Hours powered on - Shows the hours that the display is actively used 
 

 

Building/IOT Controllers 
In Manage for TEOS V3.0 we added support for IoT devices. For a full guide on how to add and use 
Building/IOT Devices please see the manual: Building & IoT for TEOS . 
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Add a Building Controller 
 
The first step to use this functionality is to add a Building Controller. To add a controller, please press 

the button: Add Building Controller:  
 
Please add the following details for the controller: 

▪ Name 
▪ Controller Brand (KNX/DALI/LoRa) 

• If LoRa is selected, please enter: 
o TheThingsNetwork region 
o TheThingsNetwork application ID 
o TheThingsNetwork access key 

▪ IP Address 
▪ Located in 

When all this information has been entered, click Save. 

Add sensors or actuators to a Building Controller 
 
After you have created a Building controller, you can add sensors to it.  
Please edit the desired building controller. On this page you can add your sensors or actuators to the 
building controller. Please see the manual “Building & IoT for TEOS  " on how to add these for your 
specific controller. 

Sensors last known values 
 
On the main Building/IoT Controllers page, you can expand an overview for your building controller. 
To expand an overview, you can click on the small arrow next to “Devices": 

 
Once expanded, you will see: 

▪ A list of all your sensors 
▪ The time of the last value received from your sensor 
▪ The location your sensor is located in 
▪ The last known value 

 
 

Equipment Management 

 
 
Here you can add equipment that is available in a meeting room. This equipment will be visible in the 
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Employee App for TEOS. You can only add equipment if your local administrator gave you the rights 
for this or if you have a role that gives you these rights.  
 
If you add equipment you need to set a name and upload an icon that will be displayed for the meeting 
room in the Employee App for TEOS. 
 

 

Manage your users 
  
To be found in the Manage for TEOS Administrator Guide. This option is only meant for 
Administrators. 

  
 

Do Advanced Configuration 
The last Administration item is used for more advanced configurations. These configurations generally 
go beyond the use of Manage for TEOS to link to other solutions. 
 
More information for this can be found in the Manage for TEOS Administrator Guide. These 
options are only meant for Administrators
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Workplace Solutions 

  
 
The menu item Workplace Solutions contains 13 items. 

 
 

Make visiting easy 
• Wayfinding (interface dedicated to help user to find space using a map, compatible with 

BRAVIA and touch screen) 

• Reception (Virtual reception to receive the visitor and help him to sign in, used mainly in tablet) 
 

Communicate clearly 
• Signage (create the presentations which includes playlists and link them to your devices) 

• Corporate TV (play streams from HLS, RTMP and UDP streamers to your BRAVIA or player) 

• Videowall (synchronize your content between different BRAVIA or players) 

• Survey (get feedbacks into your tablet for example using the digital survey interface) 
 

Streamline room bookings 
• Room Booking (create and associate your room booking interface with your tablet) 

• Class Check-in (create your class check-in workflow for your tablet), not anymore visible for new 
installations 

• Rooms Status (get in real time the activity of your meeting rooms) 
 

Master your meetings 
• Room Control (create your interface to control your device with a tablet in your meeting room) 

• Meeting Interface (show a customized interface inside your meeting room) , not any more visible 
for new installations 

• Mirroring (create your mirroring interface) 

• Meeting Display (create a workflow with actions before the meeting, during the meeting and 
after the meetings using your display BRAVIA or Android Player) 

•  
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Make visiting easy 
 

Wayfinding 
 

With the Wayfinding solution you can create Signage for tablets (15" or higher) and BRAVIA's with 

a touchscreen overlay used for visitors to find the way to a location within the building. 

It is also possible to add a News, Transport, Security to the solution. The solution also contains the 

possibility to book and search for a room. To book a room the room has to be a meeting room. 

 

Create a wayfinding solution 
 

Before you want to create a Wayfinding solution you need: 

• A SVG floor plan created by Sony. You already need to know what room names you would 

prefer on the map. Easiest way is to name these the same as the room names within Manage 

for TEOS. 

• Site management. You need Site management that contains a building with at least 1 

floor to assign the floor plan. 

• Device management. For the wayfinding solution you need a device with a Signage or a 

Tablet license. 

• Rooms in Manage for TEOS. If you want to add meeting rooms in the Wayfinding solution 

it would already help a lot if you already configured your meeting rooms, desks, receptions 

and restaurants in Manage for TEOS. These meeting rooms need to be on the correct floor 

of the selected building. For meeting rooms and desks make sure these are connected to a 

TEOS, Office 365 or Google calendar. 

To create a Wayfinding solution, go to Workplace solutions and click on the Wayfinding icon: 

  

 

Then click on the button  

This will open the Wayfinding solution screen:  
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On this screen you first need to fill in a name and select a building and then click the save button.  

After saving you can select if you want to use a landscape or portrait mode template.  

   

 After selecting click Create pages button to create the pages for the selected template.  

Floor plans 
 

In this section you can upload from version 3.1 a simple png or jpeg or an existing svg with the floor 

plans and you will be able to manage all the spaces assignment as well as path directly from the 

new tool.   

To upload an SVG floor plan to a floor click on the   this will open a popup:  

 

 

Then just click the browse button and select “Upload New Floor Plan”. Then the uploaded floor plan 

can be combined with Meeting Rooms, Desks, desk zones, restrooms staircases and parking zone, 

all the creation can be done directly by drawing the space and assign the device localization 

configured under site management > site configuration. Node and path are also created to show 

routes from the device or where the user is to a specific selected place  

In the dropdowns in the right side you can add the Meeting Rooms, Desks, if these are available 

already in the SVG file and configured within Manage for TEOS for that specific floor.  

On the right side you will see the linked Room name (in TEOS).  
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Add a device for wayfinding  

If you want to select a device for Wayfinding you can click on “create device” 

and point it in the map. Only devices located on this floor and not already used in a different 

wayfinding solution can be selected.  

  

If you have clicked on create device it will create a pin point on the map.  

    

By scrolling on the preview, you can zoom in and zoom out. If you scroll below it you will go to the 

bottom of the popup.  

 

Include a floor plan into the solution  
 

Don't forget to activate the "Included in solution" checkbox to make the floor plan visible in your 

Wayfinding solution.  

 

 A saved wayfinding solution can look something like this when saved and set to a device:  
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In front of the selected floor you will see a little arrow marker. Meeting rooms that are booked are 

coloured red and those that are not are green.  

Rooms that are not set as meeting rooms are grey.  

 

Set floor levels 
   

Click on Site management and go to Sites overview or Sites configuration which you prefer to use 

and edit a floor of the selected building in your Wayfinding solution.  

When you edit the floor you will have a new tab called "Floor map".  

   

On this tab you will also find the added floor map and a floor level selector.  

This will show the selected floor plan on the selected floor level in the Wayfinding template on your 

device.  

 

Enable multi languages 
  

Optional is to enable multiple languages. At the moment you activate this it will save the default 

and added elements you have added to the template to translations. It will create a record for every 

element in every language you have selected. If you edit your template disable and enable the 

checkbox to record the changes again. There will be an improvement for this in a future version of 

Manage for TEOS.  

  

Multi language element in the Wayfinding template  

  

When you have enabled multiple languages in Wayfinding you can go to the first page of your 

Wayfinding solution to edit this page.  

When you edit this page you will see the multi language element.  

  

 

  

When you add this to your page it will open the multi language element screen.  
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With this element you basically add a touch element which in most cases will have the picture of 

a country flag. In the setting of this multi language element you can set the language.  

When a user touches this element it will switch to the selected language and it will show the 

translations that you have manually set for these items.  

 

Wayfinding element 
  

When you edit a wayfinding page you also have the Wayfinding element you can add to the page. 

  

 

   

This will open the wayfinding element screen. 

 

News 
  

A news page is automatically generated in your Wayfinding solution.  

This is a page that can be adjusted the way you would like. It is basically the same as creating your 

signage templates.  

So if you want a tickertape on this page or like a news stream you can just add this the same way 

as when you would create signage.  

Transport 
  

The transport page will show you a map of the set environment. Something like Google maps.  

This is still under construction.  
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Security 
  

The security page is a page of which the page can be edited just like the news page in a way the 

customer prefers.  

Just like editing normal templates. Here the customer can add their security items.  

 

Book 
  

This page in your Wayfinding solution works just like room booking. 

When a room is setup like a meeting room it is possible to book a room. When you go to the Book 

page in the Wayfinding solution it will open the following screen:  

   

  

If you click on a "Book this room" button you can book the selected room. It will open the following 

screen, fill the different information required (meeting name, your name and meeting duration: 

   

When you click on book and you are allowed to book the room you will see a confirmation:  

   

The room that you have booked will turn red on your floor plan:  
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Search 

On this page in the Wayfinding solution, you can look for a room on any floor in your 

wayfinding solution and show the route to this room.If you go to Search you will see the following 

screen: 

 

You can type in the first 3 or more characters of the room name or just scroll and select the room. 

When you click on the room you want it will open a popup: 

  

 

  

If this is not a meeting room that you can book it will show the same popup without the "Book now". 

If you click now you will get the same screens as in Book. 
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If you click on "Show route" it will show you the way to the specific room. If it's on a different floor it 

will first show you the way to the stairs/elevator and then on the floor where the room is located a 

line that moves from the stairs/elevator to that specific room. 

Example for a route (created thanks to the wayfinding tool): 

 

 

Reception 
   

With the Reception for TEOS module, you can welcome visitors and notify the person they are 

visiting by e-mail or SMS. Currently the SMS services of Spryng is integrated in Manage for TEOS. 

To send messages through Spryng you will need an account, more information can be found here: 

 

http://www.spryng.nl/en 

  

 

  

  

http://www.spryng.nl/en
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Reception for TEOS will query all the users from the Manage for TEOS database so it is important 

to fill in the mobile numbers and the e-mail addresses of the persons that are in the Manage for 

TEOS database. 

 

Reception for TEOS settings 

For Administrators a new section is added in Server Management -> Settings to easily configure the 

Reception for TEOS settings. This will be explained in the TEOS Administrator guide and the dedicated 

documentation for reception.  

 

Reception for TEOS sending invitation 
 

To add the Reception for TEOS you only have to invite it using a simple email address. This email address is 
configured as an IMAP email in TEOS the next steps: 
1.        Go to file in your regular Outlook menu 
2.       Go to the agenda and open an appointment 
3.       Invite your visitor and add the reception email address in the invite 
These people will be send a code and/or a QR code by mail that they can use when they are arriving at your 
company. When they select, they have an appointment they have to fill in this code. The person who invited will 
receive a message then the person arriving filled in this code when activated for the Reception for TEOS 
template. 

  
 

Create a new Reception 

To create a new reception, go to Workplace solutions and click Reception: 

 

After that, you need to click  and fill in the logical name and select a template of your choice. If 

In TEOS software side, the configuration is done 
using IMAP to check every hour if there is an 

email received into this email address. As soon as 
TEOS get it, it will send an email automatically to 
the all the email addresses invited, using SMTP 
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wished this template can be adjusted by clicking on the pages after creating a reception. If you wish to print a 
visitor badge, select the correct printer*. The printer needs to be installed on the Manage for TEOS server. 

  

SMS 

If you wish to notify the person who is visited by SMS, you need to tick “Send SMS 

notification”. The configured Spryng SMS service will be used automatically.** 

The default number is used when the visitor has no appointment. 
 

Use agreement page  

By enabling this option, an additional page will be shown to the visitor for him to accept terms and 

conditions of the company 

 

 

Use tenant page  

Linked with the configuration done under site management > tenant management, different 

companies can be created to show in a first page the company which is visited and continue the 

process for the visitor  

 

Use camera  

Create an additional page in the workflow to be able to take a picture of the visitor and print it to the 

badge  
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Questionnaire 

A fully customizable page with a question including text boxes, check boxes and radio button can be 

created on TEOS Admin platform to be shown in the visitor sign-in process and get the feedback on 

an excel file   

 
 

License plate 

When visitor is adding is name under the sign in process, he will be able to add a license plate 

number which is saved and linked to the visitor name. Under the Reception analytics tab, the user 

will be able to check the license plate number with visitor name  

   

 

E-mail 

If you wish to notify the person who is visited by e-mail, you need to tick “Send e-mail notification”. 

The e-mail addresses of the users in TEOS will be used automatically, however your administrator 

needs to configure an SMTP server for sending e-mails. The default e-mail address is used when 

the visitor has no appointment. 

 

Printing badges   

 Printing badge can be now done via an email sent to an email to print hardware on cloud and a direct 

link to direct on-premise printer 

A new tab has been added to Content Creation to create a badge that can be printed for the visitor. 

You can add text, images, rectangles, date/time and QR code functionality to the badges. If you insert 

the text #VISITORNAME# it will replace the text with the name of the visitor. You can also 

automatically insert the contact name by inserting the text #CONTACTNAME#. The company name 

and the PIN code can be used with #COMPANYNAME# and #PINCODE# 
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Enable multiple languages 
   

For Reception for TEOSs you can enable multiple languages. 

After you edited the Reception for TEOS template the way you like you can activate the "Enable 

multiple languages" checkbox. After you selected the languages you would like to enable you can 

press the save button. 

After you saved it will make registrations for all the textblock, image and video elements on the 

page. 

  

If you then go back to Workplace solutions and then go to Receptions again you can click the 

button   

This will open a screen where you will see the element on the left with an option to translate on the 

right. In case of a text block you can add text, with an image you can select a different image and 

for a video you can set a different video for example with a different language or subtitles. 

  

 

 

Multi language element 
  

If you go to your Receptions solution in Workplace solutions - Receptions you can open one of the 

pages. Most logical page to add the multi language elements to is the Welcome page. 
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If you click on this page you can edit the page. It will show you a simular editing page like you are 

used to creating content. 

  

One of the elements is the Multi language element: 

  

 

  

This works the same as is explained in Multi language element in Wayfinding  

 

Courier services 
   

Within Receptions you will now also find special templates for Courier Services. 

  

 

  

On the home page an extra button will be displayed called "Courier information". When clicking this 

it will redirect you to the courier page:  

  

 

  

If you edit the page in your solution you can add the courier information on the page the way you 
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would prefer.    

 

Communicate clearly 
 

Signage 
 

New presentation 
 

To create a new presentation, you require the following items to be created: 

  

•     A template 

•     A page 

•     A playlist 
  

How to create a template, page and playlist is described in the chapter Content Creation. If you have 

done this correctly it means we can start creating our presentation. 

Go to Workplace solutions and click Signage: 

  

 

  

Then click button: 

 

 

 
Enter a name for your presentation and select a resolution. If you have created a masterpage, select 

the appropriate masterpage from the menu. 

 

 
 

                  
 

Next, select a playlist – in our case, this is My first playlist. 
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Click the symbol and select a playlist: 
 

 
 

Your content is almost ready for use; all you need to do is send this content to a device as explained 

earlier in this manual. 

 

Mail to signage 
 
You can specify a mailbox here from which PowerPoint (.ppt/.pptx) attachments will be read and 
automatically converted to signage content. The current presentation will then be replaced with this 
signage content. With the “Number of minutes between mailbox checks” it is possible to set the sync 
time. 

 

 

New Content Creation BETA  
When using Manage for TEOS version 3.3, we also offer to use our newly developed content designer 
(currently in beta) for creating content. Go to ‘Content Creation (Beta) > Pages’ to give it a try. 
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With the ‘Simplified’ workflow using the new content designer (beta), there are only Pages and 
Playlists. A page may contain an optional foreground and/or background page (function like a 
Masterpage). A Playlist may contain other Playlist(s) too and represents the whole ‘Presentation’: 

 
When using the new designer (beta), change the Content type accordingly and click on the 
placeholder image to select content: 

 
All details about this module are available in the dedicated signage documentation. This 
documentation can be found under https://teos.solutions/en/resources  
 
 
 

https://teos.solutions/en/resources
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Corporate TV 
 

With Corporate TV you can create a solution that will show streaming UDP, RTMP or HLS channels 
on your display. 

This functionallity is supported for displays and for the TEOS players. Tablets might give issues with 
the rendering. 

 

Creating a Corporate TV solution 
 

Go to Workplace solutions and click Corporate TV: 

  

  

  

Click the  button to create a new Corporate TV solution. 

First fill in the Name of the solution and click the save button. 

  

 

  

IPTV Channels  

When you have created a Corporate TV solution you are able to set streaming channels to the 
solution. After you added a name and url you need to click the + button to add the channel to the 
solution. 

  

Assign channels to devices 

In this section you can select a device first. Then at page you have the option to set the page to Full 
screen. This gives you the option to select 1 stream to be shown in full screen.  

The other two options are Side-by-Side and Picture-in-Picture. If you select one of these two options 
you can select 2 streams to be shown on the display. 

When you have selected your prefered options click the + button to add the channel to the selected 
device. 

  

When a device already has been selected in a Corporate TV solution it will be greyed out and it isn't 
possible to select it for the same solution twice or for a different solution until the assigned device has 
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been removed again from the solution. 

  

Supported streams 

For now UDP, RTMP and HLS are supported. 
 

Using the Connect for TEOS app 
 

You can also use the Connect for TEOS Mobile app to select de Corporate TV / IPTV channels when 
you choose control instead of casting when the channels are set in Manage for TEOS. 

You will see IPTV in your source list. You will have the same options as in Manage for TEOS to select 
from Full screen, Picture-in-Picture and Side-by-Side and then you can select the channels again. 

Recommended is to at least use version 1.9.2.0 for the Connect for TEOS Mobile app. 
 

 

Create Videowall 
 

Go to Workplace solutions and click Videowall:  

  

   

Click the button  to create a new video wall.  

You will have to fill in at least the name first and click save. Better would be to fill in all settings first.  

If you have filled in the number of displays before saving then if you edit the video wall again it will 
show you the layout where you can click the orange texts to add devices to the video wall.  

  

 

  

A full setup video wall could look like this:  
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General settings  

  

Name: The name for the video wall  

Divide content to all displays: When checked it will divide the content over all displays. When 
deactivated it will show the content on each screen.  

Rotation: Here you can set the rotation of the video wall. The content will be stretched in a way that 
all displays are filled.  

  

Number of displays  

  

Horizontal: The horizontal amount of displays  

Vertical: The vertical amount of displays  

  

Display size in mm  

  

Width: The display width in mm. (not in pixels) You can look up this size for your model display on the 
Sony website.  

Height: The display height in mm. (not in pixels) You can look up this size for your model display on 
the Sony website.  

  

Bezel size in mm  

  

Bezel top: The bezel size of the top bezel in mm. (not in pixels) You can look up this bezel size for 
your model display on the Sony website.  

Bezel right: The bezel size of the right bezel in mm. (not in pixels) You can look up this bezel size for 
your model display on the Sony website.  

Bezel bottom: The bezel size of the bottom bezel in mm. (not in pixels) You can look up this bezel 
size for your model display on the Sony website.  

Bezel left: The bezel size of the left bezel in mm. (not in pixels) You can look up this bezel size for 
your model display on the Sony website.  

Video wall in device management 
 

When you have added your video wall in Workplace Solutions - Video wall then you will see this video 
wall also in Device management.  

The devices you have used for your video wall are now visible as subdevices to your video wall.  
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 When all video wall devices are powered off the status in device management will be red (power off). 
If one of the devices is switched on the power status of the video wall itself will be green (power on).  

In the subdevices you can see exactly which devices are powered on and which are not.  

 

Survey 
  
Go to Workplace solutions and click Survey:  
  

 
  
When you click on this you can add a survey to a touch display or tablet. To do this first click the 
button: 
  

 
  
Here you can give the Survey a name and you will be able to add it as Signage to a device. You 
also want to select the template that you would like to use. When you done this click save.  
  

 
  
You will now see your Survey in the Survey tab. 
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If you click on the name of the Survey you will see the Pages of the Survey. If you click on the 
name of the Page for example you can edit it. In the “Survey Start” page you can change the 
question by double-clicking on it. 
  

 
  
When you are set you can add it as signage to the display you want to use. When people will tap 
on the smileys the results will be saved in Add-Ons 

->Survey. When you click the button you can export the data of the Survey. 
 

Streamline room bookings 
 

Room booking 
 

Create room booking 
 

Go to Workplace solutions and click Room Booking: 
  

 

To create a new Room booking click the  button. This will open the following screen. 
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Fill in Name and select a Template. Selecting Everyone means that everyone can start, extend and 
stop a meeting. Organizer only means that only the Organizer can do this using RFID. After clicking 
Save you will go to the following screen. 

 
  
You can assign the room booking template to a meeting room using “Assigned Meeting Rooms” and 

click on the  
If you would go to Sites Management -> Device Localizations and you select the meeting room you will 
see the same Presentation and Calendar have been added to the meeting room. You can in this 
section select as well the other rooms that can be shown by the room booking solution  
  

  
You will see the default room booking and next to it you see the + button. If you click on this + button 
you can select and add multiple rooms. These will show once a user will press the find another room 
button on the room booking tablet. With this functionality you can make it possible to check on a Book 
for TEOS that relates to a meeting room if another room is available when the room is already booked. 
  

Meeting room calendar 
This depends on which calendar type you are going to use. You can select a Calendar for TEOS 
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directly but you can also add a calendar that is created in Media and Data -> External Data. This is 
meant for calendars for Office365 and Google. You have to set up calendars in External Data first 
before you can use them. You can also manually add a Calendar for TEOS in this section. 
  

 
 

Native language change  
 

For Room Booking for TEOS you can use by default one of the 9 compatible languages of TEOS. 

For that you simply have at the installation time to change the language of the tablet to the native 

language to get the pop-up translated, the main page will maybe need to be translated manually 

depending on the elements used.  

Enable multiple languages 
 

For Room Booking for TEOS you can enable multiple languages. 

After you edited the Room Booking for TEOS template the way you like you can activate the 

"Enable multiple languages" checkbox. After you selected the languages you would like to enable 

you can press the save button. 

After you saved it will make registrations for all the text block, image and video elements on the 

page. 

  

If you then go back to Workplace solutions and then go to Room Booking again you can click the 

button   

This will open a screen where you will see the element on the left with an option to translate on the 

right. In case of a textblock you can add text, with an image you can select a different image and 

for a video you can set a different video for example with a different language or subtitles. 
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Multi language element 
  
If you go to your Room Booking solution in Workplace solutions - Room Booking you can open one of 
the pages. Most logical page to add the multi language elements to is the Welcome page. 

If you click on this page you can edit the page. It will show you a similar editing page like you are 

used to creating content.  

  

One of the elements is the Multi language element: 

  

 

  

This works the same as is explained in Multi language element in Wayfinding 
 
 

Room Status 
With the Room Status solution you can easily create an overview which will show the availability of all 

your meeting rooms. 

To create a Room status solution you need to go to Workplace Solutions and click Room Status. 

 
 

In the new screen click in the right top on “New Room Status" to go to the creation page. 

 
In the creation page you first need to fill in a name for your solution. 

The next step is to pick a starting localization for your Solution.  

The Room status that will be created will show the availability for all meeting rooms below the selected 

localization. In below example the final solution will show the status for all meeting rooms which are 

located on Floor 3. 

 

After you’ve selected your localization, you need to choose your template. Once you’ve selected your 

Template you can press “Save" to finalize the creation. 
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After this your Room Status is created. 

 
You can edit the design by clicking on the name below the page on the right hand side. This will open 

the normal template edit screen. 

Your design choices are limited for the Room Status template, as the overview is one element which is 

automatically populated by all meeting rooms. 

 

You can change the default image for the meeting rooms by uploading an image for the meeting room. 

To do this you need to navigate to Site Management -> Sites Configuration -> and Edit your meeting 

room. In the general tab you can Browse for an image and upload it. After uploading the image you 

need to save your meeting room group. After this the uploaded image will be used to display the 

meeting room in your Room Status solution. 
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The next step is to assign the Room status to a display.  
 

To do this navigate to Administration -> edit your device -> navigate to the “Content Settings” tab. 
On this page you can configure Default Signage for a device, or link a room status solution. To be able 

to link room status, change the first drop-down menu from “Signage Display” to “Rooms Status". 

 

After the first drop-down has been changed to “Rooms Status" you can select your created solution in 

the second drop-down. After the solution has been selected press “Save" to finalize your configuration. 

 

 
 

Master your meetings 
 

Room Control 
 

Go to Workplace solutions and click Room Control:  
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You can now create a new remote control (Remote for TEOS) that can be used for a meeting room.  
  

First click the button:     
 Here you can create your Remote for TEOS that you can use In the meeting room. 

                                 

                           
  

Then go to Administration In the main menu and go to Site Management (or If you rather use the old 
way go to Device Localizations). In Site Management lookup the meeting room that you want to add 
Remote for TEOS to. Right-click this meeting room and click "Edit". If you go to the Meeting Room tab 
you have to add the created "Room control presentation". Just select the Room Control presentation 
that you created. 

  

 
  
When you connected your Room Control presentation to the meeting room you have to go to 
Administration -> Device Management.  
  
Then select the device In the Meeting Room that you want to use as a Remote for TEOS. Most of the 
time this will be a tablet.  
Go to the Meeting Room Settings tab for this device and In "Meeting room device type" select "Room 
Control".  
  

 
  
Now your tablet should show you the devices In the room that can be remotely controlled by Remote 
for TEOS. 
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With the standard Remote for TEOS template there are 3 Devices that are shown. If you want to 
display more than 3 In Remote for TEOS go back to Add-Ons -> Room Control.  
Click on the name of your Remote for TEOS template. Then click on the "RoomControlMain" page at 
Pages. 
When you opened the template double-click on the 3 devices part of the template.  
 

 
  
This will open the following popup: 
  

 
  
Here you can select "Device Icon size". "Big" can display 1 device. "Medium" can display 3 and 
"Small" can display 10 devices. 
 

 

Meeting Interface (only on existing customers up to february 2021) 
 

Go to Workplace solutions and click Meeting Interface:  

  

 

  

After setting it up you can assign the created Meeting Interface to a meeting room in Site 
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Management -> Sites Configuration -> Edit/Create meeting room. 

 

Input configuration 
 

On the input settings area, you can give a label to an input, in order to make it logical: PC1 to 

HDMI1. You can just type the text and the display will show that name instead of HDMI1 also you 

can add a logo. You can do this for 4 HDMI ports. 

  

 

 

Meeting Room Title 

 

On the title settings, you can insert or edit two lines of text that will appear on the display, in order to 

make the name of the meeting room visible to everyone. 

  

 

  

There now also is a checkbox if you just want to use the name that has been set in Site 

Management for the Meeting Room. 

 

“Help Page"- content 

   

To add customized text to the ? in the menu within Meeting Interface on the display. 

 

Content 
  

In the content area, you have multiple options to get content on your display. 

 

• On manual input 

• Webpage Url 

• Meetings Schedule 

• Signage Content 



 

 

71 | Manage for TEOS - User guide 

 

Frame size 
  

With this option, you can decide whether you want to show the selected content in full page, bottom 

half or none at all. 

 

Content (dropdown) 
 

In the content dropdown you have 4 options: 

 

• On manual input 

o    The display is used with one of the inputs such as HDMI, as background. 

         Webpage URL 

o    You can show a webpage by inserting the URL of the website. It will be become the 

standard background of the meeting room screen. 

         Meeting schedule 

o    To add the meeting schedule to Meeting Interface. You will see the nearest upcoming 
appointments on the display. 

       Signage content 

• To display signage in Meeting Interface. 

Background colour 
   

The colour of the background that you want to use. 

 

Background transparency 
  

The transparency of the background. For example, when you are using a background image and 

the Outlook information is on, you can still set transparency. 

 

Text colour 
   

The text colour of the outlook appointments 

 

Time colour 
  

The colour of the scheduled time 

 

Description colour 
   

The colour of the appointments descriptions 

 

Web page URL 
  

To set the URL for the webpage you want to display within Meeting Interface. 

 

Signage Content 
   

You also can show signage content on the display and select an existing content. To do so, you will 

need a signage license. 
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Select Signage from the dropdown menu and then select a presentation from the signage content 

menu. Please refer to the “Signage” section in this manual to learn how to create signage content. 

 

Background image 
   

With the “Background image” option, you can choose an image that will become the display’s Meeting 

Interface background. 

 

Associated Devices and Device Groups 
 

Add device or device group 
 
Click the Add device or device group button to add a meeting schedule to a device or a device group. 

 

 

  

The Meeting Schedule dropdown will display all the calendars. (TEOS, Office365 and Google) 
If you have set this and you have set the Content dropdown to Meeting schedule it will show the 
appointments in the calendar in MRA. 
 

 

Mirroring 
 

A new Workplace Solution has been added within Manage for TEOS called Mirroring. 

With the mirroring solution you can customize your welcome screen in Connect for TEOS 

Receiver to a more corporate design for example. 

 

Create a mirroring solution 
 

Go to Workplace solutions and click on Mirroring. 

  

   

Next click the   button. This will open the screen to create a mirroring 

solution.  

First you need to fill in a name and click the save button.  
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This should have created a default template where you can click on to edit it.  

  

   

In this template you can change whatever you want. Just like normal Signage. The background will 

be an image. If you use a movie it will use the first frame of that movie.  

So recommended is to use just a normal image as background. For now only image backgrounds 

are supported.  

  

Mirroring Element  

  

If you add a Mirroring element to the template you can add a "how to connect" text block to the 

page. Just click:  

  

 

  

If you click somethere on the template after it will open the Mirroring element settings screen. On 

the "Mirroring options" tab you can select from SSID and IP Address.  
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SSID is selected when you want to add the "Mirror as a Guest" and IP Address when you want 

"Mirror through the network". The mirroring element only works in Mirroring templates.  

 

Add mirroring solution to a device 
 

To add a Mirroring solution to a device simply go to Administration and on tab Device Management 

edit the device where you want your Mirroring solution to be displayed. 

You need to have Connect for TEOS Receiver 1.9.2.0 or higher running on your display. If you 

don't have a license yet and there are licenses available you can check the "Use Connect for TEOS 

license" checkbox. 

If you then click the  button to (re-)push the license to the Connect for TEOS Receiver on your 

display. 

  

By selecting your mirroring template it will then push the Mirroring template to the Connect for 

TEOS Receiver on your display. 

 

Meeting Display 
 

One of the latest solutions within Manage for TEOS is the Meeting Display. With the meeting 

display you are able to show meeting information on your device, as well as show Signage content 

during idle periods.  

When a meeting is active you will be able to connect with HDMI or Connect for TEOS , and you can 

configure notifications to notify you if your meeting is almost ending. 

 

Create Meeting Display Solution 

To create a meeting display you need to navigate to Workplace solutions and select Meeting 

Display. 

 

Next click on “New Meeting Display" to open the creation menu. 
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In the Creation menu, you first need to enter a Name for your Solution. 

Next you can choose a template for the Meeting Display. 

The following two drop-down menus offer you a time selection for when alerts should be shown 

within your Meeting Display. This means that if there’s an active meeting, a small overlay will be 

shown on the display to notify you for the time remaining in your meeting. You can configure two 

alerts for your solution.  

The next option allows you to link a screensaver to your solution (more explained below) for idle 

moments.  

The final checkbox allows you to easily show or hide Connect for TEOS information on the screen. 

After all these settings are done you can press Save to finalize the creation. 

 
 

Meeting Display Template 

After the Meeting Display has been created, you can edit the template by clicking on the name of 

the template below Pages. This will open the template editor which you are used to. In here you 

can customize the template to your personal liking. New function under the meeting room element 

will allow to put the status of the meeting room into the template   

 

Show Connect for TEOS information 

The default templates contain placeholders for Connect for TEOS information. If Connect for TEOS 

is not installed on the displays, you can remove these elements in the template editor. Another 

option is to disable the “Show Connect for TEOS information" checkbox. When this checkbox is 

disabled it will automatically hide the Connect for TEOS information. 

Screensaver 

The Meeting Display Solution’s purpose is to show meeting information on your screen before and 

during a meeting. It is possible that there’s a longer period between meetings, which means the 
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Meeting Display has no information to show. For these periods the screensaver was introduced. 

To enable the Screensaver you should go to the edit screen of your Meeting Display. Once in the 

menu, enable the checkbox for screensaver. 

After enabling the checkbox, a couple of new options are presented: 

• Turn device off  

▪ By enabling this option, BRAVIA will stay off until a meeting is created when meeting ends, 

the screen is switched off automatically.  

• Presentation 

▪ Here you can select the Signage Presentation you want to show as your screensaver. 

• Idle time before showing 

▪ This is a period of inactivity you can specify, after which the screensaver will start. 

• Disable time before meeting 

▪ The screensaver automatically ends when a meeting starts. In case you want the meeting 

display to show x amount of time before a meeting, you can specify this time in here. 

• Enable time after meeting 

▪ If you don’t want the screensaver to start immediately after a meeting, then you can 

configure a time in here which needs to have passed after a meeting. 

• Interruptible by touch 

▪ If your Meeting Display is a touch display, then you can specify if you want the 

screensaver to be interrupted by a Touch event. If someone touches the display when this 

setting is enabled, the screen will return to the Meeting Display. 

 

 

Employee/Mobile APP  
The Employee app and Mobile app has been created to assist the employee to easily find spaces 
(rooms, desks, desk zones and parking spots). A research based on different criterias such as the date 
and time, the capacity of the room, the localization, and equipment filtering. A booking on map view 
can be done as well with instant booking.     
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To access to the employee app, an employee need to login with https://servername/employeeapp 

or with mobile apps downloading the apps under Apple Store and Play store. Process of access it 

the same putting the server name and then the login and password delivered by the administrator 

or using windows machine.  

A dedicated documentation for the configuration and the usage is available under 

https://teos.solutions/resources  

 

 

Schedules and Alarms 
 

 
In the Schedules main section, you can schedule signage content and configure power schedules. 
Here you have the following options: 
 

• Content Schedules 

• Actions Schedule 

• Alarms 

• Meeting Schedule 
 

Content schedules 
 

In this area, you can schedule signage content, media or an URL to device groups on specific times 

and dates using a user friendly calendar. 

 

https://servername/employeeapp
https://teos.solutions/resources
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By default the “Agenda” overview is selected. The supported views are: 

 
 Day - The day view shows all scheduled items for this specific device per day 

 Week - The week view shows all scheduled items for this specific device per week 

 Work Week - The Work Week view shows all scheduled items for this specific device per 

work Week so Monday until Friday 

 Agenda - The Agenda overview shows scheduled items in a list view 
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Group filter 
 

On the left side, you will see an overview of the groups. Every group has its own colour so that you 

can easily recognize them in the schedule overview. When there is a schedule active on the device, 

you will see an item in the schedule overview in the group colour. 

 
On the left side, you will see a device schedule. On the right side, you will see a group schedule: 

 

 

If you want to filter a group, you need to select the group by clicking on it. Then, please click on 

“Filter”. 

 
 

 

Create a schedule 
 

In our example, we used the week view. If you want to create a group or device schedule, you can 

select a period by holding your left mouse button and drag down or right until you have selected your 

preferred schedule time. After that, please right click on the area you have selected. It will allow you to 

choose “New Schedule”: 
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In the “Device” field, you can choose a device on which scheduling will be applied. If you prefer to 

apply it on a group of devices, please go to “Device Group” field. In the “Name” field, you can insert 

the name of the schedule. 

In the “Content” field, you can select the content (media, URL or signage) you want to schedule. 

When you tick the “Recurrence” box, you can edit the recurrence properties: 

 

 
After setting your preferences and content click the “Save” button. Your schedule will be directly shown 

in the calendar: 
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Schedule management 
Action schedules are used to schedule devices in your environment. In the overview, you will see all 

configured power and action schedules. 

 

 

Power Schedule 

To create a new power schedule, please click the button “Add action schedule”. The screen contains 

the following items: 

 
 

 

 Name - Insert a logical name, for example “Meeting Room 1 – Power schedule” 

 Action Type = Power 

 Repeat - Repeat is used for recurrence settings. For example if you want to power on every 

day. 

 On - The time that the power schedule needs to start and the devices to switch on. 

 Off - The time that the power schedule needs to stop and the devices need to switch off. 

 Forced – When checked it has priority over all other schedules except alarms. Alarms will 
always have the highest priority. 

 Device localization - The power schedule will be active on the selected group(s) 
 
There are 2 types of power schedules. A non-forced power schedule and a forced power schedule. 
You can only created a forced power schedule when you entered an “On” time and an “Off” time. 
 
Example 
 

If you want to power on your displays every day between 09:00 and 12:00 then select: 
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• “On” 

• Start 09:00 

• Stop 12:00 

• In the repeat section you select “daily” and ends “never” 
 

Priority schedules  
 
The priority with power schedules: 
 
1. Alarms 
2. Forced power schedules 
3. Action schedules 
4. Content schedules 
5. Non forced power schedules 

 
If there is another schedule or the device is playing Signage and you created an action schedule 
that should turn the device off it will not work. It will switch on again because it wants to play the 
signage. If you really want to turn the devices off the best thing to do is to create a forced power 
schedule. Unless you have a device that has no content playing or nothing scheduled. 

  

Action Schedule 
 
In the Actions Schedule section, you can schedule the commands you want to send to 

devices. Available commands for displays are: 

 Power 

 Reboot 

 Install updates 

 Start Signage 

 Meeting Room application 

 Volume 

 Mute 

 Channel Up 

 Cannel Down 

 Channels 

 HDMI1 

 HDMI2 

 HDMI3 

 HDMI4 

 Input PC DVI 

 Input PC Dsub 

 

You can start creating a command by clicking the button: 

 
After clicking that button, you will see a new window with the following options: 



 

 

83 | Manage for TEOS - User guide 

 
 
In our case, we defined an action to start the “Reboot Test Device“ during weekdays at 7:00 AM to 

device “Reboot Test Device”. You can also select a Device Localization (group) if you prefer. 

When you are finished, please click the “Save” button. Your command will be saved and scheduled. After 

that you will be redirected to the Actions Management overview screen where you can edit or delete the 

schedule: 

 

 

Make sure the schedule is set on “Active” else the action will not be executed. 

 

Alarms 
See topic Top menu or you can directly push an alarm from the tab.  

 
 

Meeting Schedule 
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Create calendar 
 

Here you can create a new schedule by selecting the date range by clicking or dragging the mouse 
over the agenda while holding the left-mouse button. On the left side you will see the meeting rooms. 
After selecting one and clicking on the Filter button it will only show the schedule for the filtered 
meeting room. 
 
If you release the left-mouse button you can click with the right-mouse button to select one of the 
following options. 
 

• New schedule 

• Today 

• Go to date 

• Settings 
 

When you choose “New schedule” the next screen will be shown. 
 

 
 
You can add the schedule to a Meeting Room and add a start and stop date and time. You can create 
recurrence for the meeting schedules too. This section is intended more for an admin management 
than for an employee usage. Employee usage is recommended to be used with the employee app.  
 
Meetings scheduled using Room Booking for TEOS or the Employee App for TEOS will also be shown 
in the meeting schedule. You are not allowed to schedule when there already is a schedule on the 
selected date and time. You will receive the following error message: 
 

 
 

Refresh calendar 
 

The calendar is refreshed now you navigate to the calendar. If you are already on the calendar page 
and you want to make sure you have the latest data on your screen you can press the 

 button
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Automation Scenarios 
 
Automation Scenarios allow you to to automate a lot of topics with an if this than that logic. To create 
your first automation Rule you can click on “Add Automation Scenario". 

 
General 
For an Automation scenario you first need to specify: 

▪ A name 

• The name for your Scenario 
▪ Active 

• The automation rule will only be executed if this checkbox is enabled. If you want to 
create a couple of rules, but don’t want to activate them immediately, you can uncheck 
this box. After creation you can also uncheck this checkbox to disable the scenario. 

▪ Action priority 

• If there are multiple scenario’s which have conflicting actions, the scenario with a higher 
priority will be executed first. Higher in this case means a higher number. So an action 
schedule with priority 20 would go above a schedule with priority 10. 

 
Next you can specify which conditions should trigger your schedule. The first choice to make is if ANY, 
or if ALL conditions need to be met for the action to trigger. Of course, this only impacts if you add 
multiple conditions. 
The second choice is to execute the action immediately when the condition is met, or if the condition is 
active for 5 minutes. An example for this is: There’s a presence sensor set up for a Meeting room. If 
employees are in the meeting room, you want to automatically create a booking, so their colleagues 
know the room is occupied. However, you don’t want to reserve the meeting room if someone walks in 
to grab a pen they forgot and walk back out. In this case you could make sure that someone is at least 
5 minutes in the room, before reserving it. 
 
Conditions 
The next step is to specify your condition which should trigger the scenario. You can specify 1 or more 
conditions. In below example we added a presence sensor, and we want to trigger the scenario when 
the sensor value equals 1 (1 = occupied, 0 = not occupied), and the calendar for TEOS has no meeting 
reserved.  
 

 
Actions 
Last but not least are the actions which should be executed when above conditions are met.  
Below example creates an Ad Hoc Meeting for 10 minutes, when someone is in the room for at least 5 

minutes while not having a reservation. This meeting will be automatically extended after 10 minutes if 

the person is stil in the room. 

 

When you’ve set up all of this information you can press Save to finalize the automation scenario. 
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All created Automation Scenarios will be visible in the main Automation screen. You can click on the 

small arrow icon in the end of a rule, to expand all information for this rule  

In this overview you can See if a Rule is Enabled (active checkbox on the rule), if it is currently Active 

or not (conditions met or not). In the expanded information you can also view all condition information, 

and the action which should be taken. 
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Content Creation 

  
 
The digital signage can be fully managed and configured using your web browser. This section is 
designed to assist you in a user-friendly way to operate Manage for Signage for TEOS and to publish 
content easily. 
 
Before starting with Content Creation please read a little further to see the Content Creation workflow. 
 
In Content Creation you will find the following tabs: 
 
To create Signage: 
 

• Masterpages 

• Templates 

• Pages 

• Playlists 
To create Printing badges for Receptions: 

• Printing Badges 
Other: 

• Content log 

• Proof of play 

• Resolutions 

 

Functionalities of Manage for Signage for TEOS 

In this area, you can schedule signage content, media or an URL to device groups on specific times 

and dates using a user-friendly calendar. 
 

Functions 

Video upload (only one video per page) v 

YouTube (only one video per page) v 

PDF integration (converted to image) v 

PowerPoint integration (converted to image) v 

Twitter integration v 

Instagram integration v 

Facebook integration v 

Websites (NTLM authentication) v 

Streaming Video (only one video per page) v 

Weather feed v 

Dynamic text v 

External data [RSS/XML] v 

Media RSS v 

Local caching * v 

Ticker tape v 

Plan module (scheduling) v 

Bandwidth-efficient ** v 
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Monitoring v 

Touch functionality v 

Interactivity v 

Offline mode v 

 

 Local caching is used to retrieve data from the server and save it to the local display. It is meant to 

ensure that content can still be displayed even when your network connection is down. Note: this 

does not apply to services such as audio and video streaming. 

** The player is bandwidth-efficient because the data is retrieved from the Manage for TEOS server 

only once. The Android application does not need to retrieve the content from the server on each 

separate occasion, making it bandwidth-efficient. 
 

Content creation workflow 

Before you start creating a presentation, the following scheme explains the signage content 

creation workflow: 

Masterpage
(optional)

Content Creation  -> 
Masterpages

Template(s)

Content Creation -> 
Templates

Presentation
(with or without 

masterpage)

Workplace Solutions -> 
Signage

Page

Content Creation -> Pages

Page

Content Creation -> Pages

Page

Content Creation -> Pages

Playlist

Content Creation -> Playlists

Playlist

Content Creation -> Playlists

 

 
The presentation represents the final content you would like to display on a screen or multiple screens: 

 The presentation itself is made up out of one or multiple playlists. 

 A playlist contains pages. 

 These pages are based on 

 Your corporate identity is guaranteed in the masterpage; this special template holds your 

company logo and elements in your corporate style and/or colours, for example. 
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Available elements 
 

 

 

Below is a list of the elements available in Manage for Signage for TEOS Designer – these are used to 

create templates and master pages. 

 

Selection tool Use the selection tool to select an element from your presentation. 

 

Media uploaded used in content creation 

 

Text element Use the text element to add text. The dialogue box will ask you to 
enter a name (your own description) and text. The [Formatting] 
tab allows you to enter the font, size, colour, style and 
transparency. 
 

 

Image 
element 

The image element allows you to add images. The dialogue box 
will ask you to enter a name (your own description). On the 
[Formatting] tab, you can select measurements and 
transparency; choose whether to keep or to change the current 
ratios; and select the appropriate alignment. 
You can upload one from your computer on the ‘Data’ tab by 
clicking [Add file(s)].  Once you have added files, you must click 
the [Start upload] button. The image will then appear in your 
media library. 

 

Video 
element 

The video element allows you to add a video that has been 
uploaded from your local file, or, alternatively, you can insert a 
Streaming URL in order to display live images of a camera (for 
example). You can do this by selecting a video on the ‘Streaming’ 
tab. The ‘Data’ tab allows you to select or upload videos. You can 
upload videos from your computer on the ‘Data’ tab by clicking on 
Add file(s). Once you have added files, you must click the Start 
Upload button. The video will then appear in your media library. 

 

Graphics 
element 

Use the graphics element to draw items in your template or 
master page; it is used, for example, to draw a background 
behind a ticker tape. You can select a colour from the Layout tab. 

 

Audio 
element 

Use the audio element to add single sound files or add an audio 
stream. TEOS is compatible with MP3 files 

 

Ticker tape 
element 

The ticker tape element allows you to add a scrolling text overlay 
(crawler). The dialogue box will ask you to enter a name (your 
own description). The Layout tab allows you to enter the font, 
size, colour, style and transparency. 
Additionally, you can enter your own text in the ‘Data’ tab. 

 

Slideshow 
element 

It’s very easy to create an image slideshow using the Slideshow 
element. By linking to images from the image database, you can 
compile your own image sequence. 
You can also set the interval between slides and choose to make 
the images semi-transparent. 

 

PowerPoint 
element 

From within a Masterpage or template, you can easily upload 
your PowerPoint files. 
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Elements with external datasources 

 

Ticker tape 
element 

In addition, you also have the option to retrieve the text from an 
external data source, for example NOS [Netherlands Broadcasting 
Foundation].  
To do so, you must click on the ‘Data’ tab and, under External data, 
select the data source you would like to use.  
To create data sources, you must read the instructions contained in the 
’External data’ section of this manual.  
 
Additionally, you can enter your own text in the ‘Data’ tab. 

 

Text element You can also retrieve the text from an external data source, for 
example CNN. To do so, click on the ‘Data’ tab, and under [External 
data], select the data source you would like to use. The ‘External data’ 
section in this manual explains how to create data sources. 

 

Image element You can upload one from your computer on the ‘Data’ tab by clicking 
[Add file(s)].  Once you have added files, you must click the [Start 
upload] button. The image will then appear in your media library. You 
can also retrieve images from an external data source, like Yahoo 
Weather. 
To do so, click on the Data tab, and under [External data], select the 
data source you would like to use. For instructions on how to create 
data sources, check the ‘External data’ section in this manual. 

 
PowerBI element Add a PowerBI dashboard, a report or a tile into your template using 

the PowerBIT external datasource. In Manage for TEOS Server 
settings you add can authenticated accesses in PowerBI using a 
Tenant ID and Secret code  

 

Streaming compatible Elements 

 

YouTube 
element 

The YouTube element allows you to add YouTube videos – for this 
you require the URL or code for your video. For example, you can 
copy the URL from your browser.  
You must then paste the YouTube code/URL onto the ‘Data’ tab 
and decide whether you would like to play all or part of the video. 

 

Vimeo element Same as Youtube only for Vimeo. 

 

Video element Under the video element you can also choose the live streaming, 
here you can put your stream URL. TEOS is compatible with 
RTMP, HLS, UDP Multicast.  

 

Audio element Use the audio element to add single sound files or add an audio 
stream. TEOS is compatible with http  

 
  
 
 
  
  
 
 
 
 
 

Manage for TEOS will automatically detect the number of pages 
and will ask you if you want to use them as single images (by 
using the slideshow element) or as a video file. 
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Element using an external web URL 

 

Website element The website element allows you to display a website. You must enter the 
complete URL on the ‘Data’ tab.  
 
You can select ‘Reload’ as an additional option; the page will then be 
refreshed each time. 

 

QR element Signage Manage for TEOS allows you to create QR codes within your 
templates and pages. Simply select the QR element tool and draw the size of 
your QR element which you prefer.  
Keep in mind that a QR element will always be square; which means you 
aren’t allowed to change its measurements.  
Once you have placed the element on your template, you now only need to 
fill in the URL which you want to trigger when the QR code is being scanned. 

Element from TEOS device or TEOS Database 

 

Date/time element The date/time element allows you to add a date and/or time. On the 
Layout tab, enter the font, size, colour, style and transparency.  
The Data tab allows you to select the format, HH:MM:SS or DD- MM-YY. 
In the device, the date/time shown is coming from the device  

 
Mirroring element Using Connect for TEOS in background and Signage for TEOS app, get 

from the device in your signage interface the IP address of the device 
shown in the interface, the SSID of the device, password of the SSID and 
device Name  
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Creating signage content 
 

Masterpages 
 

Masterpages are pages containing specific elements, for example a news ticker tape that must appear 

on every page of the presentation. You might describe it as a layer that is applied across all the pages 

of the presentation. An example of the application might include: 

You would like to use the same background using an NOS news ticker tape throughout your 

presentation. You can then create a masterpage by navigating to [Content > Master pages] in Manage 

for Signage for TEOS Designer and clicking the “New Masterpage” button. 

 
 

A new screen will now appear where you can enter the name of your masterpage and select the 

required resolution. 

 

 
 

Next, a screen will open on which you can select elements, for example a background image and a 

ticker tape. 

 

Templates 
 

In the Designer, click ‘Content’ and then ‘Templates’. In the template section, click on New template. 

 

Enter the name of the template you would like to create, select the required resolution and click 

Save. 

 
 

The following screen will appear: 
 



 

 

93 | Manage for TEOS - User guide 

 
 

 

In the template designer, you can select one of the elements that appear in the menu bar. 

If you click on the element you would like to place in the template, use your mouse to start drawing 

in the white window by right-clicking on your mouse and drawing the required dimensions. Once 

you have completed this, a window will open: (we have drawn an image in this example). 

 

 
 

You must enter a number of data in the window, including the image name. This name must be 

understandable to you and will not be displayed in the final presentation (only on the overview of 

elements on the left-hand side). 

 
The Layout tab allows you to select a number of options relating to how the element is formatted. For 

images, you have the following options: 

 
 Stretch; Fill:[Ratio is not maintained] 

 Stretch; Uniform [Ratio is maintained] The option Stretch; Fill is  

 selected by default. 
 

From the ‘Data’ tab, you can select a previously posted image, or, alternatively, you can upload one 

from your computer by clicking New upload. Next, click on the image to select it and then click on 

Save to insert the image. We have added a second image to the example (on the left-hand side), 
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called ‘Image’. 

 

Next, in the template we can select, for example, a text element and add this: 

 

 

The template is almost ready for use; we might still choose to add a ticker tape showing CNN news 
items. As explained above, we can use a ticker tape to be used on the master page or we can insert 
it into this template. For now, we are going with the second option. 

 
Click on the ticker tape element and draw a ticker tape in the black bar at the bottom. Next, give the 

element a name, for example ‘CNN ticker tape.’ On the Formatting tab, select font size 60 (this is 

standard) and the colour white. On the ‘Data’ tab, select CNN and ‘title’ as the column, then click 

Save. The title column from the CNN RSS feed is now displayed, in white and with a font size of 

60. Click on Save at the top of the page – your template is now ready for use. 

 

Pages 
 

Pages are based on templates. You can use one of the predefined templates for this purpose, or, 

alternatively, you can use a customized template. In this example, we use the “manual” template. To 

create a page, click on Content > Pages in Manage for Signage for TEOS Designer and then on 

New page. 

 

 
A screen will appear in which you must enter the name of the new page. In this page we will use 

the name My first page. Select a template and click Save. 
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The next page will open: 
 

 
 

By clicking on an element on the left-hand side, under Elements, you can make changes to your text 

or images. However, you can no longer change the positions of the elements – this is possible only in 

the template. Once you are done editing a page, click Save. 

We would now like to add our page to a playlist; to do this, we need to go to the ‘Playlists’ section.  
 

Playlists 
 

Playlists contain pages including information you would like to display on screens. A final 

presentation may contain multiple playlists, for example if you have installed a screen in the cafeteria 

and would like to display the menu along with general information. In that case, you can select a 

playlist containing both general information and menu information, in order to prevent menu 

information from being displayed on screens where it does not belong. To create a playlist and add 

pages, you must click on Content > Playlists in Manage for Signage for TEOS Designer and then on 

New playlist. 

 
 

You enter the name of the playlist, select the required resolution and click on Save. 
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A new screen will appear displaying all the pages that are available in the same resolution. 

 
 

Next, click on the page you would like to add, then click on Add to timeline. 

The page will now appear below at the bottom of the timeline. You can select the duration by dragging 

the page on the right-hand side to the right. For example, if you would like to display the page on the 

screen for 20 seconds, you should drag the page (enlarged) to 20 seconds, or, alternatively use the ‘-’ 

and ‘+’ buttons. Once you have added the page(s) required, click Save and continue to the ‘Creating 

presentations’ section. 

 

Views 
 

In the Designer, click ‘Content’ and then for example ‘Templates’. In the template section you will see 

two options for the views: 

  

 

  

You have an option to view the content in tiles or in a list view. From Manage for TEOS version 

2.1.3 also the folders will show in the list view. 

 

Printing badges (only on premise) 
 

In this new section you can create a printing badge template that can be selected and used as printing 
badge in Reception for TEOS. 
 

When you click the  button it will open a designer screen like you are used to in for 
example creating templates. 
 



 

 

97 | Manage for TEOS - User guide 

 
 
In Content Creation – Resolutions that will be explained a little further in this document you can set the 
specific resolution that you want to use for your printing badge. You have to calculate this to cm’s 
yourself. Keep in mind that the size that is actually printed might also depend on your printer settings. 
 
When you created your Printing Badge you can set it in Workplace solutions – Reception. Just create 
a new template or edit a Reception template to select it in the dropdown. 
 

Content Log and Proof of Play 
 

Content log 

 

In Content log you can see all the changes being made on content. You can search based on: 

 

• User, type in the username or a part of the username. (not case sensitive) 

• Content Name, type in content name or part of the content name. (not case sensitive) 

• Start date / End date, select within 2 dates. 

• Content types, to filter based on the content type. (multi selection possible) 

o Masterpages 

o Templates 

o Meeting Room Templates 

o Pages 

o Playlists 

o Presentations 

o Media 

Proof of play 
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This shows an overview to the user of the pages shown. 

 

 
 
Make sure the Proof of play logging is checked in Administration -> Device Management. When you 
edit (or create) a device go to the Signage settings and check the Proof of play logging checkbox. The 
first time it will take 100 pages first to be played before you will see the logging. 
 
 

Resolutions 
 
This section contains the standard resolutions for creating Signage and also gives the user an option 
to add a custom resolutions. 
 
These resolutions can be selected when creating masterpages, templates, etc. 
 
 

Add a screensaver to content 
 

From Manage for TEOS 2.1.3 it is now possible to add a screensaver to most of the solutions. The 
following solutions are supported for now: 
 

• Signage 

• Room Booking 

• Reception 

• Wayfinding 

• Room Control 

• Surveys 
  
If you are creating one of the solutions mentioned above you will now also see the following option: 
  

 
If you activate this checkbox it will show you the options for the screensaver. The options are mostly 
the same for every solution except for room booking. These has 2 more options: disable time before 
meeting and enable time after meeting. 
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Presentation:  
To select the signage you want to use for your screensaver. 
 
Idle time before showing:   
The amount of idle minutes before the screensaver starts playing. 
 
Disable time before meeting:  
The amount of minutes before a meeting that the screensaver needs to stop playing. 
 
Enable time after meeting:  
The amount of minutes after a meeting that the screensaver should start playing again. 
 
Interruptable by touch:  
When using a display/tablet with touch it is optional to interrupt the screensaver with this option by 
touching the screen. 
 

Rights 
 
You can set rights on your content for other users to be able to view, edit or delete the content that 
you have created. 
An administrator has the rights to always view, edit, or delete any content. 
If you want to set the rights for example on a masterpage go to Content Creation and click on 
Masterpages tab. You will see your created content and the content from other users if they have 
given you the rights to view this content. 
Behind your content you will see the following button: 

 
If you click this button it will open a popup which will show you the rights set for this content: 

 
Default when first entering this popup everything is blocked for users or not activated for user groups. 
Next you can set the rights for a user or user group. You can set it for a specific folder only or if you 
activate the option "Apply rights changes to subfolders and files as well" it will apply the rights for 
subfolders and files of the folder as well. 
Rights can be set for folders, subfolders and files for masterpages, templates, pages, playlists, printing 
badges, signage and media uploads.  
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Media and Data 

  
 

Media Upload 
 

The media library is used to store the media that you want to use in your environment. In the media 
library, you can create folders, upload and delete media files. You can also set the rights to make 
media available or blocked for specific users. Administrators will always have the rights to view or 
delete all media and folders. 

 

 

If you want to create a folder click the  button. 
 

After that you can click the folder name and click the  button. Then click the browse button 

to select media files that are stored locally on your PC. 
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And selecting them by clicking the media file. After that click “open” and then click upload media. 

The media file will be uploaded to Manage for TEOS. 

 

When you upload a file that is not in an expected format or with a too high bitrate. For example a 

4K movie you will get a popup with some options: 

 

 

 

You can choose to convert the file to a different size or change aspect ratio for the file. You can 

select “Keep as-is” so the file is saved without any conversions. Or you can choose not to save the 

file and delete it again. 

 

Once uploaded you can delete or view the media file by right clicking on the buttons next to it. 
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Using the user rights you can set the rights another user has using the selected media file. 
Standard other users have rights unless you choose not to. 
 

External data 
 

For external data, you can provide feeds of external sources, including RSS feeds, XML feeds or 

Twitter feeds. RSS feeds are often used to provide content for third-party programs without 

formatting. You might also have HR software that lists your employees’ birthdays in XML, allowing you 

to easily display data on your screen. 

 

RSS Feed 
 

To add a feed click External data and then New datasource in the top right of this tab: 

 
 

In this example, we will add an RSS feed from CNN (http://rss.cnn.com/rss/edition_world.rss). First, we 

name our data source CNN and then select RSS/XML: 

 

 

Click Next and the following appears: 
 

 
 
Fill out the URL for your RSS/XML feed. Should the feed require Windows authentication, you can 

also fill out the username and password here. When you are done, click Save. The external data 

source is now set up and appears in your overview: 

 

http://rss.cnn.com/rss/edition_world.rss)
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From here, you can click the icons in front of the feed to edit your feed: 

 Edit - Lets you view and/or edit what you have entered in the above  
 steps. 

 Delete - Deletes your data source from the Designer. 

 View - Opens a new browser tab to show you the data in the specific  
 feed. 
 

Data modification 
 

 Modify - Lets you replace text from your datasource to another value  

you want. 
 

 

 

An example for this would be a feed that shows the day of the week in English (Wednesday), but you 

want to show it in German (Mittwoch). In the left field, you would have to fill out Wednesday, to the 

right would be Mittwoch. 
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         Service and Catering 
 

 

 
The service and catering functionality has been created to add another step after the booking of 

meeting room which gives the possibility to deliver services created by the company on dedicated 

meeting rooms. Ability to schedule catering items and associated workflows for vendors, such as a 

dashboard and functions to manage the status of requests.  

It includes the possibility to manage 2 categories of products per room which can be customized and 

created without limit.  

Have a product element such as description of it, the amount of products available, the the cost per 

product, the cut off time (maximum time allow to change product request), image of the product, setup 

time and clean time.  

Define vendors for the products who will be able then to follow the dashboard of requests and track 

them from a new request to the delivery. 

 

 
  

A dedicated documentation is available for this module under https://teos.solutions/en/resources  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://teos.solutions/en/resources
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New Content Creation BETA 
 

 
 
When using Manage for TEOS version 3.3, we also offer to use our newly developed content designer 
(currently in beta) for creating content. Go to ‘Content Creation (Beta) > Pages’ to give it a try. A 
dedicated documentation fort Signage is explaining all the functionalities available for this usage under 
https://teos.solutions/en/resources  
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
With the ‘Simplified’ workflow using the new content designer (beta), there are only Pages and 
Playlists. A page may contain an optional foreground and/or background page (function similar to a 
Masterpage). A Playlist may contain other Playlist(s) too and represents the whole ‘Presentation’: 

 

Data 

Statistics Yes (from Dashboard, Proof of Play) 

Content log Yes 

External data integration 
Custom (RSS/XML), Weather, Facebook, Instagram, Power BI (Dashboard, 
Report, Tile), Microsoft 365 (Office), Google Calendar, Exchange, Zermelo, 
NS Info and RealWorks 

Media upload 

Image: JPG, PNG, GIF (Full HD for tablet and 8 MP for BRAVIA) 
Video: (MP4 only, BRAVIA: up to 4K@60Hz at 40 Mbps in Landscape and 
Full HD at 8 Mbps in Portrait, Tablet: Full HD at 8 Mbps 
PDF (converted to images) 
PowerPoint (converted to images) 
Audio: MP3 
Video Stream: Full HD at 5 Mbps (one per page) 

Touch interactive content Yes 

Compatible devices BRAVIA Professional Display, Android Player for TEOS, Tablet for TEOS 

https://teos.solutions/en/resources
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